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Simple Business Plan Templates

Strategic Plan Template
Focus on the future and keep your company moving forward with Jotform’s Strategic Plan Template. Simply fill in the attached form with your company overview, delve deeper with a SWOT analysis, and finish off by determining your strategic goals, actions, and financial plans. Our fully-customizable template converts submitted information into polished PDFs, which you can download, print, or share instantly.

Single Page Business Plan
Get down to business with a customizable Single-Page Business Plan template from Jotform. Customize your plan in minutes. No coding. Drag and drop to build.

Operational Plan Template
This Operational Plan Sample is structured with important details for your organization. It comes ready to print, but you can simply edit the fields by putting your own organization information.

Marketing Brief Template
Managing a marketing campaign or promotion is a challenging task. You need to have a marketing plan in order to execute the campaign smoothly with the time and budget provided. Creating a Marketing Brief is very beneficial because it summarizes the marketing strategy for a specific campaign.If you are in the advertising agency or part of the marketing department, then this Marketing Creative Brief Template is for you. This well-designed template contains the client information, project information, and the marketing materials that will be used. The project details explain the project title, description, objectives, target audience, budget overview, advertising guidelines, and competitors.

Glamping Business Plan Template
Grab the attention of the investors by using this Glamping Business Plan Template. This business plan is simple yet effective because it contains all the necessary details when building a successful business.

Lean Business Model Canvas Template
See your business from a new perspective with Jotform’s Lean Business Model Canvas Template. Simply fill in a short form with problems your business could solve, how they are currently being solved in the market, and how your company can uniquely work to solve these problems. Our template instantly converts the information into polished PDFs you can download or print for your next big meeting.Our Lean Business Model Canvas Template already looks professional, but you can personalize it further to match your business. Jotform PDF Editor lets you rearrange form fields or add your company logo at the touch of a button! By instantly converting your business model into an accessible PDF format, our Lean Business Model Canvas Template can help you see the bigger picture and determine how to take your business to the next level.

SOP Template
Create a process to organize your employees in managing specific cases or scenarios by using this SOP Template. This template is commonly used in any organization whether it is a small, medium, or large group.

Creative Brief Template
A Creative Brief is used in advertising, branding, and marketing industries. In order to have a strong and outstanding creative campaign, you need to have a game plan to follow. This serves as a guideline that will help in making decisions related to the campaign.This Creative Brief Template PDF discusses the project details like the project name, due date, and project description. The marketing materials that will be used are listed in the document which includes its specifications like the dimension size, the medium that will be used, and the quantity. This is the best Creative Brief Template you can use for your next creative marketing campaign.

Business Model Canvas Template
Our Business Model Canvas Template includes nine segments which are key partners, key activities, value proposition, customer relations, customer segments, key resources, channels, cost structure, and pricing model.

Blog Post Outline Template
Use this Blog Post Outline Template for your blog content in order to get more visitors, followers, shares, and impressions. This template will definitely help your ranking in search engines.

Gym Business Plan Template
Be successful in the gym business that you're building by securing funding or a loan with the help of this Gym Business Plan Template. This PDF can be printed and given to investors or loan applications.

Meeting Minutes Template
Set goals, plan your actions, and update your team members by tracking the team meetings by using this Meeting Minutes Template. This PDF template will surely help the team in terms of planning and productivity.

Memorandum of Understanding Template
Build a harmonious relationship between two or more parties by using this Memorandum of Understanding Template. This template is easy to use and can be customized via the PDF Editor.

Pressure Washing Estimate Template
Create estimates for pressure washing services with the use of web tools. Use this Pressure Washing Estimate PDF template and create instant estimates in PDF format without the trouble of hiring programmers.

Business Hours Template
Announce and let the customers know if your business is open and not by using this Business Hours Template. This PDF template can be customized and personalized by using the PDF Editor.

Scope of Work Template
Establish the responsibilities of the service provider by using this Scope of Work Template. This document will show the list of work and tasks that should be performed by the service provider.

Custom Sales Funnel Plan

Curriculum Vitae
Curriculum Vitae Template will provide you with all the necessary information that you need for your recruitment procedure and automate the job application process of your business.

Preliminary Notice Template
Notify the parties involved like the property owner, hiring party, notifying party, and contractor about the construction project by using this Preliminary Notice Template. This PDF template can be customized if needed via the PDF Editor.

Credit Analysis

Retainer Agreement
Create retainer agreements online. Free, easy-to-customize template. Fill out on any device. Collect e-signatures. Save time with automation tools.

Business Plan Financial Template
Create a business plan financial template with Jotform Sign. Drag and drop to customize. Fill out and e-sign from any smartphone, tablet, or desktop.

Transaction Summary

Code of Conduct Template
Create a professional code of conduct to send to your employees. Can be signed from any smartphone, tablet, or computer. Easy to customize and share. No coding.
About Simple Business Plan Templates
Plans, strategies, roadmaps – Businesses rely on these things to gain perspective on what’s about to happen. Milestones laid down in strategic and careful planning for growth and expansion, visions of where the company’s headed 10 years from now, goals that should meet timelines, all these require a smart, prudent and calculated planning.
Whether you’re a startup, an SMB, or close to a Fortune 500, a solid business plan is crucial. And of course, writing business plans is a huge task. But, what if you needed something that requires input from others though? Say, an online form or a PDF template where responses from your colleagues and managers matter? Well, here’s a collection of PDF templates for business planning.
These are beautifully designed templates, specifically tailored for businesses and companies who don’t know where to start. The hard part was already done and that’s designing the template. These will serve as boilerplates for whatever milestone your business needs. You won’t need to worry on building something from scratch, you just need to focus on the content. Some of these templates will contain or collect executive summaries, opportunities, expectations, execution, financial plans, forecasts, the whole nine yards.
Business plan templates help give a clear vision of what lies ahead. They help you get things organized, planned out, and help you check off items from your to-do list more efficiently.
Frequently Asked Questions
What are the seven parts of a business plan.
	Executive summary. This is an overview of your business plan. The executive summary should include your company’s offerings, mission, goals, and projections. Think of it as the elevator pitch for your business plan. If you can’t get investors interested here, it’s unlikely they’ll want to keep reading.
	Company description and history. Describe your business’s legal structure and history in addition to what you do. If you just started this business, you may replace company history with your leadership team’s experience. The purpose of this section is to explain the company structure and build confidence in the people running the company.
	Products and services. Talk about what your company offers, whether that’s products, services, or a combination of the two. Describe your products and services in detail. Explain what makes your offering unique, what your profit margins are, what kind of demand you’re seeing for it, etc.
	Market and competitor research. Investors want to know if there’s demand for your offering. Describe the target market and how your product or service benefits potential customers. Include projections of where the industry is headed over the next few years. Additionally, detail your competitors and how saturated the market is.
	Sales and marketing strategy. This part of the business plan explains how you’ll promote your product. Outline elements such as your ideal customer profile (ICP) as well as your marketing channels, budget, and methods.
	Operations and logistics. Explain how you’ll source materials if you sell products as well as the technology you need to deliver such products and services. Also, provide details about your team, like how many people you’ll need and how you’ll manage employees.
	Financial plan and projections. It’s crucial to prove that your business will be financially viable. For this, you’ll need revenue and expense projections. Many investors want to see sample account statements, balance sheets, and cash flow projections.

How do you write a business plan?
Your business plan should be a realistic roadmap that helps you build a successful company. When writing it, take a balanced approach so that you’re not blind to the potential pitfalls and risks. You’ll draft each of the seven sections previously discussed.
Tackling these sections can be overwhelming, so some people like to start with a one-page business plan that includes short paragraphs for each element. Another way to give yourself a head start is by working from a business plan template. Once you have a good start, you can expand each section to make a compelling case for your business.
Can I write a business plan myself?
Yes, you can. However, depending on your writing experience and goals, you may want outside help. If the business plan is for internal use with the purpose of improving business functions, you’ll likely be OK tackling it alone. But if you’re trying to secure funding from a bank or investors, a professional business plan writer can give you a leg up.
Even if you decide to do it yourself, have a trusted friend or business mentor review your plan and provide feedback. An objective point of view will help you refine your work.
What are the four types of business plans?
	One-page or mini business plan. The one-page option is a great way to improve the focus of your business plan and highlight the essential elements. It can be an effective way to workshop your company’s plan or quickly give others a rundown of your entire business.
	Traditional business plan. The traditional business plan is more in-depth than its one-page counterpart and will be more thorough in each section (often, plans exceed 40 pages). For example, it may contain detailed financials, branding samples, and competitive research documents.
	Business model canvas (BMC). The business model canvas is a more visual representation of your business architecture. It includes sections for infrastructure, offering, customers, finances, etc. Many businesses find the BMC appealing since it can be summarized in a single page.
	Strategic business plan. The strategic business plan can have different purposes, like proving feasibility, discussing planning operations, or projecting growth. It will outline the company’s goals, its strategy for reaching them, and the company structure. The main difference between this and the traditional plan is its focus on specific strategic initiatives.

What are the common mistakes in business plans?
	Poor writing. Sloppy writing may suggest that you’re not serious about your business or you lack the needed professionalism.
	Unrealistic expectations. While you should be optimistic about your business, if your financial projections reflect your hopes more than reality, people may hesitate to back your business.
	Lack of supporting documentation. People reviewing your business plan want to see how you back up your claims. You can include research docs, sample financials, and estimates to make your case.
	Failing to define the target audience. For a successful marketing plan, you need to define your target audience. Investors and financial institutions need to see if you’re confident about who you’re selling to.
	Unbalanced. It’s important to lay out the risks and potential upsides. This analysis shows investors that you’re considering the whole picture regarding your business.

These templates are suggested forms only. If you're using a form as a contract, or to gather personal (or personal health) info, or for some other purpose with legal implications, we recommend that you do your homework to ensure you are complying with applicable laws and that you consult an attorney before relying on any particular form.
Your account is currently limited to {formLimit} forms.
Go to My Forms and delete an existing form or upgrade your account to increase your form limit.
Access our library of 130 Business Templates
Wow you’ve unlocked access to our library of 130 business templates.
Get started by checking out some of our top business templates:
Featured business templates

Weekly Schedule Template
Tracking employees’ work time and wages is easy with this free weekly schedule template.

Monthly Report
Provide a professional, concise summary of project activities with this monthly report template.

One Page Business Plan Template
This one-page business plan template will help you outline the most important details about your new...
6 Free Business Plans | PDF Templates & Examples
All business plans | pdf business templates..
Showing 1 - 6 of 6

Business Case Template

Executive Summary Template

Simple Business Plan Template

Startup Business Plan Template

Strategic Planning
Explore template collections.

Customer Service

Spreadsheets

Get all Business Plans | PDF templates and more.
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Learning Objectives
After completing this chapter, you will be able to
	Describe the purposes for business planning
	Describe common business planning principles
	Explain common business plan development guidelines and tools
	List and explain the elements of the business plan development process
	Explain the purposes of each element of the business plan development process
	Explain how applying the business plan development process can aid in developing a business plan that will meet entrepreneurs’ goals

This chapter describes the purposes, principles, and the general concepts and tools for business planning, and the process for developing a business plan.
Purposes for Developing Business Plans
Business plans are developed for both internal and external purposes. Internally, entrepreneurs develop business plans to help put the pieces of their business together. Externally, the most common purpose is to raise capital.
Internal Purposes
As the road map for a business’s development, the business plan
	Defines the vision for the company
	Establishes the company’s strategy
	Describes how the strategy will be implemented
	Provides a framework for analysis of key issues
	Provides a plan for the development of the business
	Helps the entrepreneur develop and measure critical success factors
	Helps the entrepreneur to be realistic and test theories

External Purposes
The business plan provides the most complete source of information for valuation of the business. Thus, it is often the main method of describing a company to external audiences such as potential sources for financing and key personnel being recruited. It should assist outside parties to understand the current status of the company, its opportunities, and its needs for resources such as capital and personnel.
Business Plan Development Principles
Hindle and Mainprize (2006) suggested that business plan writers must strive to effectively communicate their expectations about the nature of an uncertain future and to project credibility. The liabilities of newness make communicating the expected future of new ventures much more difficult than for existing businesses. Consequently, business plan writers should adhere to five specific communication principles .
First, business plans must be written to meet the expectations of targeted readers in terms of what they need to know to support the proposed business. They should also lay out the milestones that investors or other targeted readers need to know. Finally, writers must clearly outline the opportunity , the context within the proposed venture will operate (internal and external environment), and the business model (Hindle & Mainprize, 2006).
There are also five business plan credibility principles that writers should consider. Business plan writers should build and establish their credibility by highlighting important and relevant information about the venture team . Writers need to elaborate on the plans they outline in their document so that targeted readers have the information they need to assess the plan’s credibility. To build and establish credibility, they must integrate scenarios to show that the entrepreneur has made realistic assumptions and has effectively anticipated what the future holds for their proposed venture. Writers need to provide comprehensive and realistic financial links between all relevant components of the plan. Finally, they must outline the deal , or the value that targeted readers should expect to derive from their involvement with the venture (Hindle & Mainprize, 2006).
General Guidelines for Developing Business Plans
Many businesses must have a business plan to achieve their goals. Using a standard format helps the reader understand that the you have thought everything through, and that the returns justify the risk. The following are some basic guidelines for business plan development.
As You Write Your Business Plan
1. If appropriate, include nice, catchy, professional graphics on your title page to make it appealing to targeted readers, but don’t go overboard.
2. Bind your document so readers can go through it easily without it falling apart. You might use a three-ring binder, coil binding, or a similar method. Make sure the binding method you use does not obscure the information next to where it is bound.
3. Make certain all of your pages are ordered and numbered correctly.
4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows:
1. First main heading
1.1 First subheading under the first main heading
1.1.1. First sub-subheading under the first subheading
2. Second main heading
2.1 First subheading under the second main heading
Use the styles and references features in Word to automatically number and format your section titles and to generate your table of contents. Be sure that the last thing you do before printing your document is update your automatic numbering and automatically generated tables. If you fail to do this, your numbering may be incorrect.
5. Prior to submitting your plan, be 100% certain each of the following requirements are met:
	Everything must be completely integrated. The written part must say exactly the same thing as the financial part.
	All financial statements must be completely linked and valid. Make sure all of your balance sheets balance.
	Everything must be correct. There should be NO spelling, grammar, sentence structure, referencing, or calculation errors.
	Your document must be well organized and formatted. The layout you choose should make the document easy to read and comprehend. All of your diagrams, charts, statements, and other additions should be easy to find and be located in the parts of the plan best suited to them.
	In some cases it can strengthen your business plan to show some information in both text and table or figure formats. You should avoid unnecessary repetition , however, as it is usually unnecessary—and even damaging—to state the same thing more than once.
	You should include all the information necessary for readers to understand everything in your document.
	The terms you use in your plan should be clear and consistent. For example, the following statement in a business plan would leave a reader completely confused: “There is a shortage of 100,000 units with competitors currently producing 25,000. We can help fill this huge gap in demand with our capacity to produce 5,000 units.”

Step-by-Step Guide to Writing a Simple Business Plan
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A business plan is the cornerstone of any successful company, regardless of size or industry. This step-by-step guide provides information on writing a business plan for organizations at any stage, complete with free templates and expert advice. 
Included on this page, you’ll find a step-by-step guide to writing a business plan and a chart to identify which type of business plan you should write . Plus, find information on how a business plan can help grow a business and expert tips on writing one .
What Is a Business Plan?
A business plan is a document that communicates a company’s goals and ambitions, along with the timeline, finances, and methods needed to achieve them. Additionally, it may include a mission statement and details about the specific products or services offered.
A business plan can highlight varying time periods, depending on the stage of your company and its goals. That said, a typical business plan will include the following benchmarks:
	Product goals and deadlines for each month
	Monthly financials for the first two years
	Profit and loss statements for the first three to five years
	Balance sheet projections for the first three to five years

Startups, entrepreneurs, and small businesses all create business plans to use as a guide as their new company progresses. Larger organizations may also create (and update) a business plan to keep high-level goals, financials, and timelines in check.
While you certainly need to have a formalized outline of your business’s goals and finances, creating a business plan can also help you determine a company’s viability, its profitability (including when it will first turn a profit), and how much money you will need from investors. In turn, a business plan has functional value as well: Not only does outlining goals help keep you accountable on a timeline, it can also attract investors in and of itself and, therefore, act as an effective strategy for growth.
For more information, visit our comprehensive guide to writing a strategic plan or download free strategic plan templates . This page focuses on for-profit business plans, but you can read our article with nonprofit business plan templates .
Business Plan Steps
The specific information in your business plan will vary, depending on the needs and goals of your venture, but a typical plan includes the following ordered elements:
	Executive summary
	Description of business
	Market analysis
	Competitive analysis
	Description of organizational management
	Description of product or services
	Marketing plan
	Sales strategy
	Funding details (or request for funding)
	Financial projections

If your plan is particularly long or complicated, consider adding a table of contents or an appendix for reference. For an in-depth description of each step listed above, read “ How to Write a Business Plan Step by Step ” below.
Broadly speaking, your audience includes anyone with a vested interest in your organization. They can include potential and existing investors, as well as customers, internal team members, suppliers, and vendors.
Do I Need a Simple or Detailed Plan?
Your business’s stage and intended audience dictates the level of detail your plan needs. Corporations require a thorough business plan — up to 100 pages. Small businesses or startups should have a concise plan focusing on financials and strategy.
How to Choose the Right Plan for Your Business
In order to identify which type of business plan you need to create, ask: “What do we want the plan to do?” Identify function first, and form will follow.
Use the chart below as a guide for what type of business plan to create:
Is the Order of Your Business Plan Important?
There is no set order for a business plan, with the exception of the executive summary, which should always come first. Beyond that, simply ensure that you organize the plan in a way that makes sense and flows naturally.
The Difference Between Traditional and Lean Business Plans
A traditional business plan follows the standard structure — because these plans encourage detail, they tend to require more work upfront and can run dozens of pages. A Lean business plan is less common and focuses on summarizing critical points for each section. These plans take much less work and typically run one page in length.
In general, you should use a traditional model for a legacy company, a large company, or any business that does not adhere to Lean (or another Agile method ). Use Lean if you expect the company to pivot quickly or if you already employ a Lean strategy with other business operations. Additionally, a Lean business plan can suffice if the document is for internal use only. Stick to a traditional version for investors, as they may be more sensitive to sudden changes or a high degree of built-in flexibility in the plan.
How to Write a Business Plan Step by Step
Writing a strong business plan requires research and attention to detail for each section. Below, you’ll find a 10-step guide to researching and defining each element in the plan.
Step 1: Executive Summary
The executive summary will always be the first section of your business plan. The goal is to answer the following questions:
	What is the vision and mission of the company?
	What are the company’s short- and long-term goals?

See our  roundup of executive summary examples and templates for samples. Read our executive summary guide to learn more about writing one.
Step 2: Description of Business
The goal of this section is to define the realm, scope, and intent of your venture. To do so, answer the following questions as clearly and concisely as possible:
	What business are we in?
	What does our business do?


Step 3: Market Analysis
In this section, provide evidence that you have surveyed and understand the current marketplace, and that your product or service satisfies a niche in the market. To do so, answer these questions:
	Who is our customer? 
	What does that customer value?

Step 4: Competitive Analysis
In many cases, a business plan proposes not a brand-new (or even market-disrupting) venture, but a more competitive version — whether via features, pricing, integrations, etc. — than what is currently available. In this section, answer the following questions to show that your product or service stands to outpace competitors:
	Who is the competition? 
	What do they do best? 
	What is our unique value proposition?

Step 5: Description of Organizational Management
In this section, write an overview of the team members and other key personnel who are integral to success. List roles and responsibilities, and if possible, note the hierarchy or team structure.
Step 6: Description of Products or Services
In this section, clearly define your product or service, as well as all the effort and resources that go into producing it. The strength of your product largely defines the success of your business, so it’s imperative that you take time to test and refine the product before launching into marketing, sales, or funding details.
Questions to answer in this section are as follows:
	What is the product or service?
	How do we produce it, and what resources are necessary for production?

Step 7: Marketing Plan
In this section, define the marketing strategy for your product or service. This doesn’t need to be as fleshed out as a full marketing plan , but it should answer basic questions, such as the following:
	Who is the target market (if different from existing customer base)?
	What channels will you use to reach your target market?
	What resources does your marketing strategy require, and do you have access to them?
	If possible, do you have a rough estimate of timeline and budget?
	How will you measure success?

Step 8: Sales Plan
Write an overview of the sales strategy, including the priorities of each cycle, steps to achieve these goals, and metrics for success. For the purposes of a business plan, this section does not need to be a comprehensive, in-depth sales plan , but can simply outline the high-level objectives and strategies of your sales efforts. 
Start by answering the following questions:
	What is the sales strategy?
	What are the tools and tactics you will use to achieve your goals?
	What are the potential obstacles, and how will you overcome them?
	What is the timeline for sales and turning a profit?
	What are the metrics of success?

Step 9: Funding Details (or Request for Funding)
This section is one of the most critical parts of your business plan, particularly if you are sharing it with investors. You do not need to provide a full financial plan, but you should be able to answer the following questions:
	How much capital do you currently have? How much capital do you need?
	How will you grow the team (onboarding, team structure, training and development)?
	What are your physical needs and constraints (space, equipment, etc.)?

Step 10: Financial Projections
Apart from the fundraising analysis, investors like to see thought-out financial projections for the future. As discussed earlier, depending on the scope and stage of your business, this could be anywhere from one to five years. 
While these projections won’t be exact — and will need to be somewhat flexible — you should be able to gauge the following:
	How and when will the company first generate a profit?
	How will the company maintain profit thereafter?

Business Plan Template

Download Business Plan Template
Microsoft Excel | Smartsheet
This basic business plan template has space for all the traditional elements: an executive summary, product or service details, target audience, marketing and sales strategies, etc. In the finances sections, input your baseline numbers, and the template will automatically calculate projections for sales forecasting, financial statements, and more.
For templates tailored to more specific needs, visit this business plan template roundup or download a fill-in-the-blank business plan template to make things easy. 
If you are looking for a particular template by file type, visit our pages dedicated exclusively to Microsoft Excel , Microsoft Word , and Adobe PDF business plan templates.
How to Write a Simple Business Plan
A simple business plan is a streamlined, lightweight version of the large, traditional model. As opposed to a one-page business plan , which communicates high-level information for quick overviews (such as a stakeholder presentation), a simple business plan can exceed one page.
Below are the steps for creating a generic simple business plan, which are reflected in the template below .
	Write the Executive Summary This section is the same as in the traditional business plan — simply offer an overview of what’s in the business plan, the prospect or core offering, and the short- and long-term goals of the company. 
	Add a Company Overview Document the larger company mission and vision. 
	Provide the Problem and Solution In straightforward terms, define the problem you are attempting to solve with your product or service and how your company will attempt to do it. Think of this section as the gap in the market you are attempting to close.
	Identify the Target Market Who is your company (and its products or services) attempting to reach? If possible, briefly define your buyer personas .
	Write About the Competition In this section, demonstrate your knowledge of the market by listing the current competitors and outlining your competitive advantage.
	Describe Your Product or Service Offerings Get down to brass tacks and define your product or service. What exactly are you selling?
	Outline Your Marketing Tactics Without getting into too much detail, describe your planned marketing initiatives.
	Add a Timeline and the Metrics You Will Use to Measure Success Offer a rough timeline, including milestones and key performance indicators (KPIs) that you will use to measure your progress.
	Include Your Financial Forecasts Write an overview of your financial plan that demonstrates you have done your research and adequate modeling. You can also list key assumptions that go into this forecasting. 
	Identify Your Financing Needs This section is where you will make your funding request. Based on everything in the business plan, list your proposed sources of funding, as well as how you will use it.

Simple Business Plan Template

Download Simple Business Plan Template
Microsoft Excel |  Microsoft Word | Adobe PDF  | Smartsheet
Use this simple business plan template to outline each aspect of your organization, including information about financing and opportunities to seek out further funding. This template is completely customizable to fit the needs of any business, whether it’s a startup or large company.
Read our article offering free simple business plan templates or free 30-60-90-day business plan templates to find more tailored options. You can also explore our collection of one page business templates . 
How to Write a Business Plan for a Lean Startup
A Lean startup business plan is a more Agile approach to a traditional version. The plan focuses more on activities, processes, and relationships (and maintains flexibility in all aspects), rather than on concrete deliverables and timelines.
While there is some overlap between a traditional and a Lean business plan, you can write a Lean plan by following the steps below:
	Add Your Value Proposition Take a streamlined approach to describing your product or service. What is the unique value your startup aims to deliver to customers? Make sure the team is aligned on the core offering and that you can state it in clear, simple language.
	List Your Key Partners List any other businesses you will work with to realize your vision, including external vendors, suppliers, and partners. This section demonstrates that you have thoughtfully considered the resources you can provide internally, identified areas for external assistance, and conducted research to find alternatives.
	Note the Key Activities Describe the key activities of your business, including sourcing, production, marketing, distribution channels, and customer relationships.
	Include Your Key Resources List the critical resources — including personnel, equipment, space, and intellectual property — that will enable you to deliver your unique value.
	Identify Your Customer Relationships and Channels In this section, document how you will reach and build relationships with customers. Provide a high-level map of the customer experience from start to finish, including the spaces in which you will interact with the customer (online, retail, etc.). 
	Detail Your Marketing Channels Describe the marketing methods and communication platforms you will use to identify and nurture your relationships with customers. These could be email, advertising, social media, etc.
	Explain the Cost Structure This section is especially necessary in the early stages of a business. Will you prioritize maximizing value or keeping costs low? List the foundational startup costs and how you will move toward profit over time.
	Share Your Revenue Streams Over time, how will the company make money? Include both the direct product or service purchase, as well as secondary sources of revenue, such as subscriptions, selling advertising space, fundraising, etc.

Lean Business Plan Template for Startups

Download Lean Business Plan Template for Startups
Microsoft Word | Adobe PDF
Startup leaders can use this Lean business plan template to relay the most critical information from a traditional plan. You’ll find all the sections listed above, including spaces for industry and product overviews, cost structure and sources of revenue, and key metrics, and a timeline. The template is completely customizable, so you can edit it to suit the objectives of your Lean startups.
See our wide variety of  startup business plan templates for more options.
How to Write a Business Plan for a Loan
A business plan for a loan, often called a loan proposal , includes many of the same aspects of a traditional business plan, as well as additional financial documents, such as a credit history, a loan request, and a loan repayment plan.
In addition, you may be asked to include personal and business financial statements, a form of collateral, and equity investment information.
Download free financial templates to support your business plan.
Tips for Writing a Business Plan
Outside of including all the key details in your business plan, you have several options to elevate the document for the highest chance of winning funding and other resources. Follow these tips from experts:.
	Keep It Simple: Avner Brodsky , the Co-Founder and CEO of Lezgo Limited, an online marketing company, uses the acronym KISS (keep it short and simple) as a variation on this idea. “The business plan is not a college thesis,” he says. “Just focus on providing the essential information.”
	Do Adequate Research: Michael Dean, the Co-Founder of Pool Research , encourages business leaders to “invest time in research, both internal and external (market, finance, legal etc.). Avoid being overly ambitious or presumptive. Instead, keep everything objective, balanced, and accurate.” Your plan needs to stand on its own, and you must have the data to back up any claims or forecasting you make. As Brodsky explains, “Your business needs to be grounded on the realities of the market in your chosen location. Get the most recent data from authoritative sources so that the figures are vetted by experts and are reliable.”
	Set Clear Goals: Make sure your plan includes clear, time-based goals. “Short-term goals are key to momentum growth and are especially important to identify for new businesses,” advises Dean.
	Know (and Address) Your Weaknesses: “This awareness sets you up to overcome your weak points much quicker than waiting for them to arise,” shares Dean. Brodsky recommends performing a full SWOT analysis to identify your weaknesses, too. “Your business will fare better with self-knowledge, which will help you better define the mission of your business, as well as the strategies you will choose to achieve your objectives,” he adds.
	Seek Peer or Mentor Review: “Ask for feedback on your drafts and for areas to improve,” advises Brodsky. “When your mind is filled with dreams for your business, sometimes it is an outsider who can tell you what you’re missing and will save your business from being a product of whimsy.”

Outside of these more practical tips, the language you use is also important and may make or break your business plan.
Shaun Heng, VP of Operations at Coin Market Cap , gives the following advice on the writing, “Your business plan is your sales pitch to an investor. And as with any sales pitch, you need to strike the right tone and hit a few emotional chords. This is a little tricky in a business plan, because you also need to be formal and matter-of-fact. But you can still impress by weaving in descriptive language and saying things in a more elegant way.
“A great way to do this is by expanding your vocabulary, avoiding word repetition, and using business language. Instead of saying that something ‘will bring in as many customers as possible,’ try saying ‘will garner the largest possible market segment.’ Elevate your writing with precise descriptive words and you'll impress even the busiest investor.”
Additionally, Dean recommends that you “stay consistent and concise by keeping your tone and style steady throughout, and your language clear and precise. Include only what is 100 percent necessary.”
Resources for Writing a Business Plan
While a template provides a great outline of what to include in a business plan, a live document or more robust program can provide additional functionality, visibility, and real-time updates. The U.S. Small Business Association also curates resources for writing a business plan.
Additionally, you can use business plan software to house data, attach documentation, and share information with stakeholders. Popular options include LivePlan, Enloop, BizPlanner, PlanGuru, and iPlanner.
How a Business Plan Helps to Grow Your Business
A business plan — both the exercise of creating one and the document — can grow your business by helping you to refine your product, target audience, sales plan, identify opportunities, secure funding, and build new partnerships. 
Outside of these immediate returns, writing a business plan is a useful exercise in that it forces you to research the market, which prompts you to forge your unique value proposition and identify ways to beat the competition. Doing so will also help you build (and keep you accountable to) attainable financial and product milestones. And down the line, it will serve as a welcome guide as hurdles inevitably arise.
Streamline Your Business Planning Activities with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.

The Perfect Business Plan Layout & Outline
Written by Dave Lavinsky

The layout of a business plan is not an area where great imagination and creativity is needed or recommended. It should be a more or less straightforward task to layout or outline your plan, using industry standard practices which funders have become familiar with through thousands of business plans. Use the following steps to implement this standard layout and save creativity for your business idea within the plan.
Download our Ultimate Business Plan Template here >
Start by getting your hands on a good business plan template. This will speed your time to completing your plan. Business plans generally start with an executive summary and company overview, move through background research and market analysis, customers, and competition, describe the company’s intended methods in the marketing plan and operation plan, show who’s on the management team, and conclude with the financial plan and appendices featuring full financial statements.
Use the business plan template to guide your understanding of each section and to see how they relate to each other. Don’t assume that any one example should dominate your understanding unless it comes from an extremely trusted source with a reputation for business plan expertise and success.
Business Page Layout Tips
How to finish your business plan in 1 day.
Don’t you wish there was a faster, easier way to finish your professional business plan?
With Growthink’s Ultimate Business Plan Template you can finish your plan in just 8 hours or less!
Click here to finish your business plan today.
Sample Business Plan Outline
1. executive summary.
Your executive summary is the most important part of your plan. It comes at the beginning and is the first thing investors or lenders will read. If they aren’t excited by what they see, they’ll unfortunately stop reading. So make sure your executive summary gives a quick overview of what your company does and explains, in an exciting tone, why your company will be successful.
In your Company Description, provide background on your company. When did you incorporate? What have you accomplished to date? Here you will let readers know the history of your business.
In the Market Analysis section of your business plan provide background on the industry in which you operate. Conduct market research to make this section concrete and compelling. Answer questions such as: how big is your industry? what trends are affecting it?
Here you will document your target market. How are they? How many are there? What are their likes and dislikes? Ideally you can provide comprehensive demographic and psychographic profiles of your target customers and show how your company’s product or service are ideally suited to their needs.
In this section of your business plan, document your key competitors. Explain their strengths and their weaknesses. Remember that investors and lenders expect you to have direct competitors. They just want to feel confident that despite them, you can still achieve lasting success.
Finish Your Business Plan in 1 Day!
Don’t you wish there was a faster, easier way to finish your business plan?
Your marketing strategy should primarily focus on the promotional methods you will use to attract new customers. Will you use search engine marketing? Will you employ radio ads? Document each of the promotional methods you will use.
This section of your plan should discuss the key roles that your company must expertly perform and your strategies for operational excellence. You must also outline the long-term milestones your company plans to accomplish and the key dates for each.
In your Management Team section, detail the key members of your team. Document their backgrounds and how their past experiences make them well suited to succeed in your organization.
Here you will layout the key assumptions used in creating your financial model and then provide topline results from your income statement, balance sheet and cash flow projections. If you are seeking funding, document the amount of funding you seek and the key uses for it.

In your Appendix, you will provide supporting information such as employee or customer agreements, store layouts, etc. You must also include your full, five-year financial model and projections.
By following the above business plan outline, you will ensure your plan is in the format investors and lenders expect.
OR, Let Us Write a Business Plan For You
Since 1999, Growthink has developed business plans for thousands of companies who have gone on to achieve tremendous success.
Click here to see how Growthink’s business plan consulting services can create your business plan for you.
Business Page Layout FAQs
How do i lay out a business plan.
Laying out a business plan is not, and should not, be complicated. You can lay out your business plan using our sample business plan outline discussed here . An organized business plan structure is key to a successful business plan. 
What is a business plan outline?
A business plan outline allows you to organize your plan and present it in the format that’s most compelling to readers. Also, by starting with your outline, it’s easier to add the required information into the right sections of your business plan.
Other Helpful Business Plan Articles & Templates


Restaurant Business Plan PDF Example

	February 21, 2024
	Business Plan


Creating a comprehensive business plan is crucial for launching and running a successful restaurant. This plan serves as your roadmap, detailing your vision, operational strategies, and financial plan. It helps establish your restaurant’s identity, navigate the competitive market, and secure funding for growth.
This article not only breaks down the critical components of a restaurant business plan, but also provides an example of a business plan to help you craft your own.
Whether you’re an experienced entrepreneur or new to the food and beverage industry, this guide, complete with a business plan example, lays the groundwork for turning your restaurant concept into reality. Let’s dive in!
Our restaurant business plan is structured to cover all essential aspects needed for a comprehensive strategy. It outlines the restaurant’s operations, marketing strategy, market environment, competitors, management team, and financial forecasts.
	Executive Summary: Offers an overview of the restaurant’s business concept, market analysis, management, and financial strategy.
	Restaurant & Location: Describes the restaurant’s prime location, size, seating capacity, and distinctive design, emphasizing its appeal to the target demographic.
	Supply & Operations: Outlines the supply chain management, focusing on local sourcing and quality ingredients, and details the operational aspects, including kitchen layout, equipment, and front-of-house operations.
	Key Stats: Shares industry size, growth trends, and relevant statistics for the full-service restaurant market.
	Key Trends: Highlights recent trends affecting the restaurant sector, such as health-conscious dining, sustainability, and technology integration.
	Key Competitors: Analyzes the main competitors in the vicinity, showcasing the restaurant’s unique selling proposition in comparison.
	SWOT: Strengths, weaknesses, opportunities, and threats analysis.
	Marketing Plan: Strategies for promoting the restaurant to maximize visibility and customer engagement.
	Timeline: Key milestones and objectives from the initial setup through the launch and operational optimization.
	Management: Information on who manages the restaurant and their roles.
	Financial Plan: Projects the restaurant’s financial performance, including revenue, profits, and expected expenses, aiming for profitability and sustainable growth.


Restaurant Business Plan
Download an expert-built 30+ slides Powerpoint business plan template
Executive Summary
The Executive Summary introduces your restaurant’s business plan, offering a concise overview of your establishment and its offerings. It should detail your market positioning, the variety of cuisines and dining experiences you offer, its location, size, and an outline of day-to-day operations. 
This section should also explore how your restaurant will integrate into the local market, including the number of direct competitors within the area, identifying who they are, along with your restaurant’s unique selling points that differentiate it from these competitors. 
Furthermore, you should include information about the management and co-founding team, detailing their roles and contributions to the restaurant’s success. Additionally, a summary of your financial projections, including revenue and profits over the next five years, should be presented here to provide a clear picture of your restaurant’s financial plan.
Make sure to cover here _ Business Overview _ Market Overview _ Management Team _ Financial Plan

Dive deeper into Executive Summary
Business Overview
For a Restaurant, the Business Overview section can be concisely divided into 2 main slides:
Restaurant & Location
Briefly describe the restaurant’s physical environment, emphasizing its design, ambiance, and the overall dining experience it offers to guests. Mention the restaurant’s location, highlighting its accessibility and the convenience it offers to diners, such as proximity to entertainment venues or ease of parking. Explain why this location is advantageous in attracting your target clientele.
Supply & Operations
Detail the range of cuisines and dishes offered, from appetizers and main courses to desserts and specialty beverages. Outline your sourcing strategy, ensuring it reflects a commitment to quality and sustainability, and matches the market you’re targeting. Highlight any unique culinary techniques, exclusive ingredients, or innovative kitchen technologies that set your restaurant apart. Discuss your operational strategies, including inventory management, supplier relationships, and kitchen workflow, to ensure efficiency and consistency in delivering exceptional dining experiences.
Make sure to cover here _ Restaurant & Location _ Supply & Operations

Market Overview
Industry size & growth.
In the Market Overview of your restaurant business plan, start by examining the size of the restaurant industry and its growth potential. This analysis is crucial for understanding the market’s scope and identifying expansion opportunities.
Key market trends
Proceed to discuss recent market trends, such as the increasing consumer interest in farm-to-table dining, ethnic cuisines, and experiential dining experiences. For example, highlight the demand for restaurants that offer unique cultural dishes, the growing popularity of health-conscious and dietary-specific menus, and the integration of technology in enhancing the dining experience.
Key competitors
Then, consider the competitive landscape, which includes a range of dining establishments from gourmet fine dining to fast-casual eateries, as well as the rise of food delivery services and meal kits. For example, emphasize what makes your restaurant distinctive, whether it’s through a unique culinary approach, a niche market focus, or a strong commitment to sustainability and local sourcing. This section will help articulate the demand for restaurant services, the competitive environment, and how your restaurant is positioned to thrive within this dynamic market.
Make sure to cover here _ Industry size & growth _ Key market trends _ Key competitors

Dive deeper into Key competitors
First, conduct a SWOT analysis for the restaurant , highlighting Strengths (such as a unique menu and exceptional customer service), Weaknesses (including potential high operational costs or strong competition in the area), Opportunities (for example, a growing interest in diverse cuisines and healthy eating), and Threats (such as economic downturns that may decrease consumer spending on dining out).
Marketing Plan
Next, develop a marketing strategy that outlines how to attract and retain customers through targeted advertising, promotional discounts, an engaging social media presence, food blogger outreach, and community involvement, such as local events or charity sponsorships.
Finally, create a detailed timeline that outlines critical milestones for the restaurant’s opening, marketing campaigns, customer base growth, and expansion objectives, ensuring the business moves forward with clear direction and purpose.
Make sure to cover here _ SWOT _ Marketing Plan _ Timeline

Dive deeper into SWOT
Dive deeper into Marketing Plan
The management section focuses on the restaurant’s management and their direct roles in daily operations and strategic direction. This part is crucial for understanding who is responsible for making key decisions and driving the restaurant towards its financial and operational goals.
For your restaurant business plan, list the core team members, their specific responsibilities, and how their expertise supports the business.

Financial Plan
The Financial Plan section is a comprehensive analysis of your financial projections for revenue, expenses, and profitability. It lays out your restaurant’s approach to securing funding, managing cash flow, and achieving breakeven.
This section typically includes detailed forecasts for the first 5 years of operation, highlighting expected revenue, operating costs and capital expenditures.
For your restaurant business plan, provide a snapshot of your financial statement (profit and loss, balance sheet, cash flow statement), as well as your key assumptions (e.g. number of customers and prices, expenses, etc.).
Make sure to cover here _ Profit and Loss _ Cash Flow Statement _ Balance Sheet _ Use of Funds

Privacy Overview

Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	Free PDF Business Plan Templates
Simple Business Plan Template PDF This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide.




	Write your business plan
Executive summary Briefly tell your reader what your company is and why it will be successful. Include your mission statement, your product or service, and basic information about your company's leadership team, employees, and location. You should also include financial information and high-level growth plans if you plan to ask for financing.




	Free Simple Business Plan Templates
Strategic planning Simple Business Plan Templates Try Smartsheet for Free By Joe Weller | April 2, 2020 In this article, we've compiled a variety of simple business plan templates, all of which are free to download in PDF, Word, and Excel formats.




	Free editable and printable business plan templates
677 templates Create a blank Business Plan Beige Aesthetic Modern Business Plan A4 Document Document by Rise & Roar Design Navy and Gray Modern Business Plan Cover Document Document by Banuaa Grey and White Modern Business Plan Cover Document A4 Document by Ubara Startup Business Plan in Cream Black and White Modern Sophisticated Style




	How to Write a Business Plan: Guide + Examples
Business planning How to Write a Business Plan: Step-by-Step Guide + Examples Noah Parsons 24 min. read Updated February 2, 2024 Download Now: Free Business Plan Template Writing a business plan doesn't have to be complicated.




	PDF HOW TO WRITE A BUSINESS PLAN
1. Internal: Providing management and staff with a clear map, complete with signposts and milestones against which progress can be monitored and evaluated. 2. External: Presenting the investment case to an outsider. This key function provides the focus for this note. Essentially, business plans are sales documents.




	20+ Simple Business Plan Templates
Drag and drop to build. Business Plan Use Template Operational Plan Template This Operational Plan Sample is structured with important details for your organization. It comes ready to print, but you can simply edit the fields by putting your own organization information. Business Plan Use Template Marketing Brief Template




	PDF Getting started on your business plan: A workbook
A well-crafted plan will continue to serve you throughout the life of your business. Expect to update your document regularly to ensure the information is current and aligns with the overall goals and growth of your organization. Instructions: Use this workbook to solidify and document the core components of your business plan.




	Free Business Plan Template for Small Businesses (2024)
Download a free business plan template in Google Doc, Microsoft Word, and PDF formats.




	Business Plan Template in PDF
Use our downloadable free business plan template PDF to outline your company's goals and milestones, including how to structure, run, and grow your new business. Bring on investors or new business partners Use your powerful business plan to get funding or bring on new business partners.




	Free Startup Business Plan Templates
This one-page business plan is ideal for startup companies that want to document and organize key business concepts. The template offers an easy-to-scan layout that's ideal for investors and stakeholders. Use this plan to create a high-level view of your business idea and as a reference as you flesh out a more detailed roadmap for your business.




	6 Free Business Plans
Startup. A collection of professionally designed Business Plans templates available for PDF. Download, customize, and send in minutes.




	Download Free Business Plan Examples
Download a free business plan in PDF or Word doc format to make writing a plan fast and easy Find Your Sample Plan Discover the sample plan that best fits your business. Search our gallery of over 550 sample business plans and find the one that's right for you. View the Gallery What You'll Get:




	1.1: Chapter 1
Make certain all of your pages are ordered and numbered correctly. 4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows: 1. First main heading. 1.1 First subheading under the first main heading. 1.1.1.




	Free simple business plan templates to edit and print
68 templates Create a blank Simple Business Plan Restaurant Business Plan in Terracotta Coral Peach Friendly Dynamic Style Document by Canva Creative Studio White and Blue Modern Business Plan Cover Page Document by cavani team Clothing Business Plan in Navy White Minimal Corporate Style Document by Canva Creative Studio




	How To Write A Business Plan (2024 Guide)
Describe Your Services or Products. The business plan should have a section that explains the services or products that you're offering. This is the part where you can also describe how they fit ...




	Business Plan
A business plan should be structured in a way that it contains all the important information that investors are looking for. Here are the main sections of a business plan: 1. Title Page. The title page captures the legal information of the business, which includes the registered business name, physical address, phone number, email address, date ...




	Business Plan Templates: 26 FREE Samples
Business plan templates From competitive analysis to financial projections, business plans give your new business a roadmap for success. Download one of our free business plan templates and take your company to the next level. Featured Accounting & tax Affidavit Forms Bill of sale Big Data Startup Business Plan Template




	How to Write a Simple Business Plan
What Is a Business Plan? A business plan is a document that communicates a company's goals and ambitions, along with the timeline, finances, and methods needed to achieve them. Additionally, it may include a mission statement and details about the specific products or services offered.




	PDF This
This Business Plan Template from is one of many free downloads available at Bplans.com This template is a simplified business plan outline. It's a good way to get started, but as you know, you can't just type in your details, print it, and turn it in to the bank. Every business is unique, and your business plan should reflect that.




	The Perfect Business Plan Layout & Outline for a Great Plan
To help you get started, you can download our business plan outline pdf or follow the outline below: 1. Executive Summary Your executive summary is the most important part of your plan. It comes at the beginning and is the first thing investors or lenders will read. If they aren't excited by what they see, they'll unfortunately stop reading.




	PDF Business Plan Guide for pdf
MASSACHUSETTS SMALL BUSINESS DEVELOPMENT CENTER NETWORK BUSINESS PLAN GUIDE A structured guide with worksheets to assist you in the development of your business plan, financial projections, and operating budget. Adapted from materials written by Donald J. Reilly Southeastern MA Regional Small Business Development Center 200 Pocasset Street




	Restaurant Business Plan PDF Example
February 21, 2024. Business Plan. Creating a comprehensive business plan is crucial for launching and running a successful restaurant. This plan serves as your roadmap, detailing your vision, operational strategies, and financial plan. It helps establish your restaurant's identity, navigate the competitive market, and secure funding for growth.




	PDF Business Plan
the Business it is agreed that the Recipient undertakes to the Business to treat as confidential the Business Plan and all information in any medium or format (whether marked "confidential" or not) whether in writing or oral which the Recipient receives during the relationship from the Business ( Confidential Information ). 2. The Recipient ...




	Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print. To do this, you will start with baseline content in a document, potentially via a form template. Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to ...
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